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Common Adjustments
Now let’s look at other adjustments that I end 
up applying to the majority of my images. Each 
of these features are found under the various 
tabs that appear above the adjustment sliders 
in Camera Raw.
Chromatic Abberations: Almost all lens-
es produce colorful halos on the edges of high 
contrast objects (like a rod iron fence against 
a blue sky). Turning on the Remove Chromatic 
Abberation checkbox that’s found under the 
Color sub-tab within the Lens Corrections 
section of ACR. If you still see purple or green 
halos after turning on that checkbox, then 
consider adjusting the Purple Amount and 
Green Amount sliders that are found in the 
same area. The Purple Hue and Green Hue slid-
ers determine the range of colors that will be 
affected and can be used to narrow or expand 
the range that’s being adjusted. 
Lens Corrections: If your image was shot 
with a fisheye lens and you’d like to remove 
the destortion caused by the lens, then click on 
the Lens Corrections tab, click on the Profiles 
sub-tab and then turn on the Enable Lens 
Profile Corrections checkbox. If you tilted your 
camera upward when shooting a rectangular 
object (like a tall building), then you may need 
to click on the Manual sub-tab within the Lens 
Corrections area of ACR. That’s where you’ll 
find the Vertical slider, which can be used to 
un-destort the image so that vertical lines 
within the image are actually vertical instead 
of slanted.
Noise: If you end up bringing up the 
Shadows or Exposure slider a great deal, then 
plan to apply noise reduction to your image. 
Those sliders don’t introduce noise, they simply 
make it easier to see where it used to lurk in 
the overly dark areas of your image. The higher 
the ISO setting in your camera, the more noise 
you will see. The controls for noise reduction 
are found under the Detail tab above the 
adjustment sliders (it looks like a triangle icon).

In noisy images, the first thing I do is to 
make sure the default sharpening is not exag-
gerating the problem by applying sharpening 
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to areas that don’t contain useful detail. To accomplish that, I’ll hold the Option key (Mac), or Alt 
key (Win) and drage the Masking slider toward the right. That should present you with a different 
view of your document where areas that appear as white will be sharpened while areas that are 
solid black will not be sharpened at all. The idea is to move the slider to the right until black cov-
ers all areas that do not contain any useful detail. If it’s an area where you can’t see any texture or 
detail at all, then get it to turn black. The most common areas would be blue cloudless skies. 

Next, bring up the Luminance slider in the Noise Reduction area below the Sharpening sliders. 
You’ll need to zoom up to 100% view by double-clicking on the Zoom tool to really see the noise 
effectively. Bring up the Luminance slider until 
the noise is no longer objectionable. If the 
image contains a lot of fine detail (hair, leaves, 
etc.), then increase the Luminance Detail slider 
until you find a setting that gives you a good 
compromise between noise reduction and 
retaining detail. 
Post Crop Vignetting: If you’d like to 
darken the edges and corners of your image 
in an attempt to draw attention to the center 
potion of your image, then adjust the sliders 
found under the Post Crop Vignetting section 
of the Effects tab. Watch out if there are any 
bright highlights near the edge of the frame 
since darkening the edges will not look natu-
ral in those areas. When that’s the case, set 
the Style pop-up menu to Highlight Priority 
and then adjust the Highlights slider until the 
bright highlights break through the vignetting 
effect. If you don’t have bright highlights near 
the edge of the image, then setting the Style 
pop-up menu to Color Priority will usually pro-
duce a better looking end result.
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Adjustment Brush
If you need to apply the adjustment sliders 
to isolated areas of your image, then you 
should switch to the Adjustment Brush, which 
is found among the tools at the top of the 
Camera Raw dialog box (it’s the brush without 
the dots around it).

When the Adjustment Brush is active, you’ll 
be presented with a limited number of adjust-
ment sliders on the right side of the Camera 
Raw dialog box. Moving those slider won’t 
change your image *until* you paint over 
your image with the Adjustment Brush.  Here 
are some common uses for the Adjustment 
Brush:
Mixed Light Sources: Adobe added the 
Temperature and Tint sliders in Photoshop 
CS6. They allow you to compensate for differ-
ent colored light sources. An example would 
be when you can see through a window to 
another space that is lit with a different type 
of light source (tungsten versus florescent for 
example). 
Smooth Faces: I often increase the 
Clarity setting when adjusting the whole 
of the image. That doesn’t help any faces in 
the scene since it will exaggerate wrinkles 
and other facial features. I’ll often note the 
amount of Clarity being applied to the entire 
image and then set the Clarity setting in the 
Adjustment Brush to a negative amount equal 
to what’s applied to the rest of the image. I 
might even go further to smooth a face. So, if 
I have +20 Clarity applied to the whole image, 
then I’ll use the adjustment brush to apply -30 
Clarity to someone’s face, which will end up 
applying -10 to the face total (the other -20 
just compensates for the +20 applied to the 
entire image).
Pushing Settings Beyond +100%: 
If you max out any of the adjustment sliders 
that are found under the Basic tab, then consider using the adjustment brush to further boost the 
same setting by painting over the entirety of the image using the same adjustment type.
Moire Removal: If you notice an odd pattern of color on textiles that does not fit with the 
general appearance of the item, then consider using CS6’s new Moire slider in the adjustment 
brush to see if it is able to reduce or eliminate the problem. 

Adjust Multiple Images: 
You can select multiple images in 
Bridge and then choose Open in 
Camera Raw from the File menu 
to adjust multiple images. Before 
moving any of the adjustment 
sliders, click on the image that 
you’d like to be viewing and then 
click the Select All button in the 
upper left. Changes to the sliders 
will affect all the images that are 
actively selected. That is exactly 
what is needed to adjust all the 
images that make up a panorama 
before the images are stitched into 
a single image composite.  Once 
the panorama has been stitched, 
you can flatten the image and save 
it as a TIFF file, which can be further 
adjusted using Adobe Camera Raw.
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Waterfall Enhancement: I often find that I have to darken the highlights of waterfall shots 
to maintain detail in the sky, but doing so will usually cause the highlights in the waterfall to 
appear dull and gray. To remedy the situation, I’ll paint over the waterfall with the Adjustment 
Brush with the Highlights and Clarity sliders turned up.
Defringe: If your image contains colorful halos around the edges of objects that do not belong 
in the image, first attempt to remove them using the controls found in the Color sub-tab of the 
Lens Corrections tab. If that doesn’t work, then try painting over the area with the Adjustment 
Brush using the new Defringe option. 
Settings: The Flow setting determines how much of the adjustment you’ll get in your first paint 
stroke and then you’ll have to paint back and forth over the same area to build up the adjust-
ment. Set this slider to 100% if you’d like the full power of the adjustment on the first paint stroke. 
The Auto Mask checkbox will attempt to prevent you from getting overspray beyond the edge of 
objects in your image.  It’s all based on the crosshair that appears inside your brush. It will only 
allow changes to areas that are similar in brightness and color to what’s under the crosshair, so 
don’t let it touch areas that shouldn’t be adjusted. 

Use Option/Alt to Access Special Features
Hold Option (Mac), or Alt (Win) with the following features to get a different view of your image 
that can be helpful when performing adjustments:
Detail Tab: Hold the Option key when adjusting the Amount and Radius settings for sharpen-
ing to temporarily switch to a grayscale version of your image, which can make it easier to judge 
when you have the proper amount of 
sharpening. Also hold Option when 
adjusting the Masking slider to see a 
mask where white areas indicate what 
will be sharpened and black areas will 
prevent sharpening from being applied. 
The idea is so only sharpen areas that 
have useful detail and don’t sharpen 
areas where noise would be the main 
detail (think solid blue sky). 
Split Tone Tab: Hold Option while adjusting the Hue settings to more easily see which color 
is being chosen. That will cause the preview to appear as if the Saturation slider was set to its 
maximum setting. Also hold Option when adjusting the Balance slider to get a similar view, which 
can make it much easier to see where the toning is affecting various areas within your image.
Lens Correction Tab: Under the Color sub-tab, holding Option while you drag the sliders 
will show you which areas within your image would be affected by each slider. You can also hold 
the Command key (Mac), or Ctrl key (Win) and click within your image on a purple or green halo 
to have Photoshop calculate the proper slider settings to rid your image of the halo.
Effects Tab: Holding the Option key while dragging the sliders found under the Post Crop 
Vignetting area will temporarily display the vignette as if the Amount setting was set to -100, 
which should make it easier to get a sense for what each slider controls. 
Buttons: Holding the Option key will cause the buttons that appear at the bottom of the 
Camera Raw window to change. The Cancel button will become Reset, allowing you to reset all 
the sliders to the state they were in when you opened the image into camera raw. The Open 
Image button will become Open Copy, which will open your image using the current camera raw 
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settings without updating the raw file on your hard drive to reflect those settings. That way you 
can create a oddly cropped B&W version of an image for instance that will not affect what the 
raw file will look like the next time its opened in Photoshop. Holding the Shift key will change 
the Option Image button into Open Object, which will cause the image to be opened as a Smart 
Object in Photoshop. A Smart Object contains a copy of the original raw file, which allows you to 
double-click on the thumbnail image for the layer in the Layers panel to return to camera raw and 
change the setting being applied to the layer.

2010 Process
In 2012, Adobe changed how the sliders in Camera Raw work by changing the name and behavior 
of the sliders that were available in previous versions of the program. If you open an image that 
was adjusted in an older version of Photoshop, then you’ll find a small exclamation point show-
ing up near the lower right corner of the image. When that symbol is present, the older versions 
of the sliders will be in affect so that you can open the image with the same general appearance 
you’ve had in the past. If you click the symbol, 
then the image will be updated and the newest 
sliders will appear. If you ever need to adjust 
an image using the old versions of the sliders, 
then click on the Calibration tab in Camera Raw 

and set the Process pop-up menu to 2010. 

Document Settings
A line of text should appear below your image in the Camera Raw dialog box. That text indicates 
the document settings that will be used when you open the image into Photoshop. To change the 
settings, click on the text, which should produce a dialog box full of settings. Here is how I think of 
some of those settings:

Space: This setting determines the range of colors you can use within your image. sRGB is the 
most limited, Adobe RGB allows for somewhat more saturated colors and Pro Photo RGB allows 
to extremely vivid colors. If you hate thinking about technical details and just want things to look 
good and don’t mind loosing a tiny amount of potential quality, then I’d suggest that you set the 
menu to sRGB. If you print to a high quality desktop ink jet printer and would like to be able to 
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reproduce nice vivid colors, then I’d suggest you use Adobe RGB. I’d only suggest Pro Photo to 
someone who is truly educated about how these settings work since you can easily mess up your 
image if you push things too far when using that setting. You can tell when it might be sueful 
to consider going with a larger color space than what you are using right now (sRGB=smallest, 
AdobeRGB=medium, Pro Photo=crazy huge). 

When adjusting the Saturation or Vibrance sliders in Camera Raw, keep an eye at the histogram 
(bar chart) that appears in the upper right of the Camera Raw window. If you see tall colorful 
spikes on the very end of the histogram, then changing to a large color space might be benefi-
cial. If you get huge spikes, then that’s an indication that you might be loosing detail in the most 
saturated areas of your image. You can see exactly where this is happening by holding down the 
Option key and clicking on the Blacks slider (if the colorful spike was on the left edge of the histo-
gram), or the White slider (if it was on the right edge of the histogram). In that view, any area that 
appears in color is loosing some detail. Inspect those areas to see if the detail loss is noticeable 
and then try a large color space to see if the detail returns. If so, then a larger color space might be 
a good choice for that particular image. The color space setting is only important for images that 
contain very vivid colors and would have little affect on “normal” images.
Depth: This setting determines how many brightness levels Photoshop will use between white 
and black in your image. 8 bits will give you 256 brightness levels, while 16-bits will give you many 
thousands of brightness levels. You won’t notice a visual difference between the two settings on 
most images. I recommend that most people leave this setting at 8 bits. If you notice banding 
across the sky of stitched panoramas would I suggest upping the setting to 16 bits, which will 
cause your file size to double. If anyone ever attempts to talk you into using 16 bits for all your 
images, challenge them to show you a visual difference between images that use 8 versus 16 bits. 
If all they can show you is a histogram, then ignore them. If you can’t see a visual difference, then 
there is no use in doubling your file size.

HDR in Camera Raw 7
In Photoshop CS6, you can process High Dynamic Range images using Adobe Camera raw. Here’s 
what’s necessary to do that:
1) Merge Images using Merge to HDR Pro: Start by selecting the exposures within 
Bridge, then choose Tools>Photoshop>Merge to HDR Pro. 
2) Use 32-bit: When the merge to HDR pro dialog box appears, set the bit depth to 32-bit and 
then click OK.
3) Save as TIFF: Next, choose File>Save As and save the image as a TIFF using default set-
tings. Close the image and if prompted choose “Don’t Save” since you’ve already saved the image.
4) Open through bridge: Point Bridge at the folder you saved the above TIFF file in, click on 
the file once to get it selected and then chose File>Open in Camera Raw
5) Adjust Using ACR: Adjust the image just like any other using the techniques mentioned 
in this handbook. You’ll likely need to lower the Highlights and increase the Shadows setting.

The techniques described above were demonstrated during PhotoshopWorld Orlando in April of 2013. An 

updated version of this presentation was demonstrated in Las Vegas. The remaining pages of this handbook 

cover the techniques that were added or changed in this session for the Las Vegas event. 
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Targeted Adjustment Tool
The Targeted Adjustment Tool is found near the upper left of the Camera Raw window (fifth icon 
from the right, just to the left of the Crop tool) and can be used while the Curve or HSL tab is 
active. When the HSL tab is active, clicking on your image and dragging right to left will cause 
Photoshop to analyze your image and determine which sliders would most effectively target the 
color upon which you click. This can really speed up the adjustment process since you can simply 
click on the various colors within your image, switch between the Hue, Saturation and Lightness 
sub-tabs to determine what you’d like to change and drag without having to think of which slid-
ers would be most effective. 

Upright
This new addition in Photoshop CC is found 
under the Lens Corrections tab’s Manual 
sub-tab. Let’s look at the settings from left to 
right:
Off: This setting disables the upright feature 
and is useful when the other settings are not 
effective on an image.
Auto: Analyzes the image and attempts to 
apply a balanced amount of correction. This 
is not simply choosing from the other three 
options, but it creating a hybrid of those cor-
rections, so be sure to try it on each image to 
see if it provides a more pleasing result than 
the other options. 
Level: This setting attempts to cause 
straight lines that are close to being horizon-
tal to become perfectly horizontal. It’s rather 
useful when shooting handheld where the 
horizon and the tops of buildings might be a 
little bit off from horizontal. 
Vertical: This setting will help to correct for 
the distortion caused by tilting your camera 
up when shooting buildings and other rect-
angular objects. It will attempt to straighten 
the converging lines the make up the verti-
cals on a building. If the resulting image looks 
stretched vertically, then try adjusting the 
Aspect setting that is found near the bottom of the sliders that are below the Upright icons. 
Full: This setting will attempt to correct both the tops and sides of buildings and other rectangu-
lar objects so that they end up being perfectly vertical and horizontal. 

As you move to the right with each of the Upright icons you are applying additional corrections. That means 

each icon incorporates all of the adjustments that would be applied with the icons that are found to their left, 

so that the left-most icon applies all possible corrections. 
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Spot Removal
Adobe has added some new functionality to the Spot Removal tool that is found near the upper 
left of the Camera Raw window. A few of these features will only be found when using the 
Creative Cloud version of Photoshop. 
Visualize Spots: This new checkbox is found below the sliders near the lower right of the 
Camera Raw window. Turn the checkbox on and then move the slider until you see white lines 
around the dust spots that might be found in the sky of your image. If you find that it’s difficult to 
see them, then consider lowering the Exposure or Highlights setting that’s found under the Basic 
tab before turning on the feature. 
Alternative Source: When you click within your image, Photoshop will automatically choose 
an area from the surrounding image to use as the source for cloning. If you don’t like the area it 
has chosen, press the / key to have it pick an alternative location for cloning. You can press the / 
key multiple times until you find that the tool has chosen an effective source to clone from.
Manual Source Selection: If you’d rather manually choose the area that will be used as the 
source for cloning, then hold the Command key (Mac), or Ctrl key (Win), then click on the area that 
needs to be retouched and then drag to where you would like to clone from.
Non-round Cloning: If the area you need to retouch is not easily contained within the circu-
lar cursor that Photoshop presents when using the Spot Removal tool, then drag across the area 
instead of simply clicking and releasing the mouse button. That will allow you to paint over an 
area and when attempt to remove things such as telephone lines.

Panoramas in 16-bit
You will find a line of text below your image in Camera Raw that indicates the settings that will 
be used when you open your image in Photoshop. You can click on that text to change the set-
tings. There is a strong debate amongst Photoshop users as to if and when 16-bit should be used. 
In my experience the vast majority of images would look fine if opened as 8-bit which delivers 
256 brightness levels to Photoshop. I use 16-bit, which delivers thousands of brightness levels to 
Photoshop, but produces files that are twice as large on your hard drive, when I need to stitch a 
panorama since I find it can produce smoother transitions in the sky. I also use the setting when I 
need to apply the Healing brush in overly smooth areas such as skies.

Contents Based on Online Course: The concepts and techniques mentioned in this 
handbook are based on the content of my online class on Camera Raw, which is to be released in 
October 2012. For more details visit DigitalMastery.com.
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Ben Willmore has personally trained well over 100,000 Photoshop users. He is the author of the award-win-
ning, best-selling book Adobe Photoshop Studio Techniques and co-author of How to Wow: Photoshop for 
Photography. Ben was also the author of the “Up to Speed” series, which covered only the new features in 
Adobe Photoshop. Ben also has created a set of Photoshop Training DVDs available on his web site at www.
DigitalMastery.com. Ben has many free resources available on his web site (found under the Freebies tab) that 
includes: Photoshop Tips, Magazine Articles and the Image Ambulance Service. If you’d like the ultimate in 
Photoshop education, consider bringing Ben to your organization to teach your workforce.  

Here’s what other people have said about Ben:  
“When we get stuck, we call Ben” -Scott Kelby, President, National Association of Photoshop Professionals 
“Ben Willmore’s knowledge of Photoshop is second to none.” -Vincent Oliver, Digital PhotoFX Magazine 
“Ben Willmore is highly respected by the Photoshop team.” -Sandra Alves, User Interface Designer, Adobe Systems, Inc.

Ben is currently living a mobile lifestyle exploring the U.S. in a 40’ motorcoach.  
You can follow his adventures on his blog at www.WhereIsBen.com and see his photography at www.theBestofBen.com.


